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1. Introduction to Kernel for Outlook

Welcome to the user manual for Kernel for Outlook, the most effective and convenient .PST file repair tool

available that recovers emails from broken PST file. This user manual comprises step by step guidelines
on using Kernel for Outlook.

1.1 Using this Manual

This user manual is intended to guide users on using Kernel for Outlook. We suggest that first time users
should read this user manual completely and carefully before proceeding to use the software. However, if
you are an experienced user, you can use the table of contents to find out information pertaining to the
tasks that you need to perform by using Kernel for Outlook.
You can use the table of contents to navigate through different sections of this user manual. The table of
contents lists all the sections that are contained in this user manual in chronological order. The user
manual comprises the following sections:

e Introduction

o Getting Started

e Software Interface

o Repairing PST Files

e Full Version

e Support

e Troubleshooting

e Legal Notices

Certain abbreviations have been used throughout this manual. For clear understanding of the contents of
this user manual, please go through the list of abbreviations, mentioned below, before reading the manual.

1.1.1 List of Abbreviations

PST: Personal Storage Files

QFSCI: Quick File System Component Identification
MS: Microsoft

RAM: Random Access Memory

MB: Mega-Byte

GB: Giga-Byte
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1.2 About Kernel for Outlook

Kernel for Outlook is a PST repair tool which recovers and restores emails and other related data items
like attachments, calendars, appointments, contact, journals and notes etc. from corrupt, damaged or
broken PST files. There are various reasons for corruption of PST files, for instance storage limit of 2GB
has exceeded, header structure has got corrupt, virus attacks, accidental deletion of emails, and loss due
to exchange server corruptions.

You usually get the following error messages once the PST file has gone corrupt:

o Errors have been detected in file file_path'

e Unable to expand the folder

e The file could not be repaired therefore cannot be reopened

Kernel for Outlook PST Repair uses quick algorithm for searching and restoring the lost, corrupt or deleted
personal folder files (.pst) email messages within minutes. Even the password protected PST files are
unlocked and emails are recovered with Kernel for Outlook.

The files which have exceeded 2GB space limitation are successfully repaired, so file size is not a
constraint at all for Kernel for Outlook. The software is equipped with four saving options:

e Save as PST: Emails and other items are saved in PST file
e Save as EML: Emails and other items are saved in EML file(s)
e Save as MSG: Emails and other items are saved in MSG file(s)

e Save as DBX: Emails and other items are saved in DBX file

1.3 Salient Features

Salient features of Kernel for Outlook include:

e Recovers permanently deleted emails

e Recover emails from corrupt PST file

e Recover emails from broken PST file which get corrupt due to 2GB limitation of MS Outlook

e Recovers all items including mails, draft, calendars, contacts, journal, tasks, notes etc.

e Recovers emails from password protected pst files also

e Equipped with saving options

e Supports email recovery from .PST files created with MS Outlook 97, 2000, 2002(XP), 2007 and 2003

e Free demo to experience capabilities of the tool before purchasing it
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1.4 Who Should Use this Software?

Kernel for Outlook is PST email repair software which uses QFSCI technique to recover the damaged or
corrupt personal folder files (.pst files). It is useful even when the 2GB file limitation has been exceeded, if
there is accidental email deletion, or virus attacks.

It is useful for those who have lost their important emails, contacts and that particular lose is taking a toll
on their business continuity. Kernel for Outlook is a definite solution to all the PST file corruptions and one
must go for the evaluation version of the software to test its recovery capabilities.
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2. Getting Started

Now that you have understood the features and potential of Kernel for Outlook, you are ready to get a
hand on experience of the software. To start repairing .PST files, you will first need to download and install
this software.

It is strongly recommended that before installing Kernel for Outlook, you should go through the installation
pre-requisites for the software to ensure that your computer is appropriately configured to run the
software.

2.1 Installation Pre-requisites

The various pre-requisites for installing and running Kernel for Outlook can be broadly classified into two
major categories — Hardware requirements and Software requirements.

2.1.1 Hardware Requirements:

The hardware requirements for installing the software are as follows:
e Pentium Class Processor
e Minimum 64MB RAM (128 MB recommended)
e 10MB for Software installation

e Disk Space - Enough space to store the repaired PST files

3. You should have at-least 10 MB of free disk space if you want to repair and save a
10 MB .pst file.

2.1.2 Software Requirements:

The software requirements for installing the software can further be grouped into two categories —
Operating system requirements and Microsoft Outlook version requirements. The requirements are as
follows:

2.1.2.1 Operating System Requirements
Supported Operating Systems:

e Windows Vista

e Windows XP

e Windows 2003

e Windows 2000
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2.1.2.2 Microsoft Outlook Version Requirements
Supported Microsoft Outlook versions:

e MS Outlook 97

e MS Outlook 98

e MS Outlook 2000

e MS Outlook 2003

e MS Outlook 2007
2.2 Downloading Kernel for Outlook for the First Time

After checking your computer with the prescribed system requirements for Kernel for Outlook, you can
download and install the software on your computer. You can buy the full version of the software from any
one of our authorized resellers— Element5, Asknet and 2CO.

If you want to try using Kernel for Outlook before buying it, you can download the evaluation version from
the following link:

http://www.nucleustechnologies.com/Download-Microsoft-Outlook-Mails-Recovery-Software.php

X You can repair the corrupt PST files by using the evaluation version of Kernel for
Outlook; however, the evaluation version lets you view the preview of the repaired
file but does not save the recovered emails until you purchase Full version of the
software.

2.3 Install Kernel for Outlook

After downloading the installer file for Kernel for Outlook, you can install the software by running the file.
To install Kernel for Outlook:

1. Double-click the Kernel for Outlook installer. Follow the on-screen instructions.
The Setup Installation Complete screen will be displayed.

2. Click Finish to launch the software.

2.4 Start Kernel for Outlook

To start Kernel for Outlook:
Click the Start = All Programs >Kernel for Outlook

Alternatively, you can launch Kernel for Outlook by double-clicking the shortcut icon available on the
Desktop and Quick Launch icon.
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2.5 Uninstall Kernel for Outlook

You may need to uninstall Kernel for Outlook. To uninstall
1. Click the Start = All Programs >Kernel for Outlook - Uninstall Kernel for Outlook
A warning message will be displayed.

2. Click Yes to uninstall Kernel for Outlook.

. Before proceeding to uninstall Kernel for Outlook, you must ensure that the software
is not running in system background.

You can alternatively uninstall Kernel for Outlook from the Control Panel by performing the following
steps:

1. Click the Start Menu = Control Panel and then double click the Add or Remove Programs icon.
2. Select Kernel for Outlook and click Remove.
A warning message will be displayed.

3. Click Yes to uninstall Kernel for Outlook.
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3. Software Interface

Now that Kernel for Outlook has been installed on your computer, you can start using the software after
getting acquainted with the software interface.

3.1 Menu-bar

The menu-bar of Kernel for Outlook comprises three main menus — File, Tools, and Help.

3.1.1 File Menu

The File menu comprises three menu items.

File | Tools  Help

| | Bepair |
I Save

Exit

Figure 3.1: File Menu

Menu items in the File menu:

Repair Select to start the repairing of corrupt PST files

Save Select to save the recovered emails and other items from PST
files

Exit Select to close the software

3.1.2 Tools Menu

The Tools menu comprises five menu items.

—

ools | Help

Standard

T

Skatus Bar

Theme »

&

Live Update

Debug mode

Figure 3.2: Tools Menu
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Menu items in the Tools menu:

Standard Select to show or hide Tool bar/Standard bar
Status Bar Select to show or hide Status bar

Theme Select to change the software theme

Live Update Select to get the latest version of software
Debug mode Select to generate a log file for Kernel software

3.1.3 Help Menu

The Help menu comprises three menu items.

File

>

Tools

Figure 3.3: Help Menu

Menu items in the Help menu:

Help Select to view help information pertaining to performing
various tasks using Kernel for Outlook

Buy Online Select to purchase the software online from the website

About Kernel For Outlook Select to view version-related and support information of
Kernel for Outlook

3.2 Tool-bar

A
m
~
2
m
X
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The tool-bar in Kernel for Outlook is displayed below the menu-bar. The tool-bar provides a convenient
and user-friendly method to perform certain actions that can also be performed by using the menu-bar.
Read the information in the table below to find out about the tool-bar buttons:

Repair

Save

Live Update

Live Update

z ! Help

Buy Online

EUﬁ Cnline

Select to repair the selected PST file

Select to save the recovered PST file items

Select to get the latest version of the software

Select to view the User Guide of the software

Select to purchase the software online from the

website
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3.3 Status Bar

Status bar is displayed at the bottom of the software window. The text ‘Ready’ is displayed on the status
bar if Kernel for Outlook is ready to be used. Status bar also displays the text ‘CAP’, ‘NUM’, ‘SCRL’ which
respectively correspond to the Caps Lock, Num Lock, and Scroll Lock keys on your keyboard. If any of
these keys are pressed, the color of the corresponding text will turn blue/black.

Ready CAP| SCRL

Figure 3.4: Status Bar

3.4 Buttons Used

Apart from the standard options available in the menu-bar and the tool-bar, following are the main buttons
used throughout the software:

Click to select the corrupt .pst file from your system

Ecan Click to start the process of repairing the corrupt .pst file

Click to stop the repairing process

o] His

Skop

Back Click to view the previous screen

Click to save the recovered file items

;

Save

—. Click to return to the main window of Kernel for Outlook

3.5 Customize User Interface

You can add or remove toolbar buttons by clicking:

E 2> Add or Remove Buttons > Standard in the toolbar and selecting appropriate buttons.
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4. Repairing PST Files

Now that you have complete familiarity of the user interface of Kernel for Outlook, you are ready to repair

.pst files.

To repair .PST files:

1. Launch Kernel for Outlook.

IK| Kernel for Outlook

! File Tools

Repair

Help

PH G QU

Save Live Update Hel

Flease select File to repair

Buy Online

Kernel

- Gcan

Kernel for Outlook | Ready

SCRL

2. Select the corrupt PST file by clicking the L] button.

©ONucleus Data Recovery.Com Private Limited
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K. Kernel for Outlook E'@'E'
‘e Took Help
Q@ @ Kernel

Recovery Tools

Flease select file bo repair

H:\Outlook Files\Kernel2. pst R

Eernel for Dutlook Read:.l' SCRL
Figure 4.2: Selected PST file

3. Click the Scan button to start the process of scanning.
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K. Kernel for Qutlook El@' E’

z
§
g

KernEel

Recovery Tools

[0 7af Deleted Items &
O L3 mbox{s7) <--
O3 Cutbox
O 5 Sertt Items
O 55 Calendar
O 5 Contacts
O L3 Drafts
O 54 rournal -
g :._ﬁl :_‘::E Please wait repairing process is in progress...

= OL Sync Issues

EL'_] Conflicts

e T I N N,
W

4 > =

[kernel Repairing Process |

Ermnails ;BT Notes 20 Current Process (3/3): extracting data......

Calerndar  : 0 (T | | stop

Done SCRL

Eernel for Outlook

Figure 4.3: Repairing Process

4. Software will recover the user mailbox folders of the PST file and list the emails and other items in tree
like structure.

5. View preview of the recovered emails in the software:
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K Kernel for Outlook

Kernel

Recovery Tools

Recovered Folder ||t @ [3 From To Subject Date ~
=B L2 Top of Personal Folders ~ ) IrformiT Promotions  DOOQWIUIoUswomws,  Cresting Short Films F...  Thursday, January 0.,
B (& Deleted Items d 2 I . E—— . Mcrosoft Office Outl...  Thursday, January 0.,
= E.___‘I Personal Folders =1 seomail ‘Mucleus Technologies...  RE: Happy New Year Friday, January 06, 2...
& B 7 root - Publc .:\I secmail ‘Wuclewss Technologies..,  RE: Happy New Year Friday, January 06, 2...
= [ [ Root - Maibox i ' = R —— - - —
) common views From Inform(T Promations To [EEEEEEEEEEEEa
-84 L3 Finder Subject  Creating Short Films for the Web
[ [0 shorbeuts
B TRy -
= & 7] 1Pt_SUBTREE Macremedia Flash Professional # Beyond the Wiorld of War craft'® Penny Arcad
B (8] Deleted Rems Basics Hands.0n Training Jan 11, 2006
_} Pk Prodeenal | By Shane Rebenschisd 6,99 (Save 30°%)"
[ LS Outbox Dec 28, 2005 )
= ﬂ Sart: Toor §31 .49 (Save 30%)* Paostal Clerk ani ark I
:E Calendar Bry John Gosney, Davwn Rosenberg, b
B4 4 Contacts Discrete-Event Simulatior: A First Course Lipson
[ ..é Drafes o Bry Larry Lesmis, Stephen Park Jan 13, 2006 L
£ T - 3 < 3
Emsails : 410 Mobes Hil
Cortact  : 0 Task : D
Jounsl ¢ 0 Calendar : 0 [ Bock | [ seve |

Keernmel For Dutlook SCRL

Figure 4.4: Recovered Files

6. Select the checkbox for the corresponding recovered folder which you want to save and click the Save
button.

7. After clicking the Save button, the software provides you four options to save the repaired pst file. i.e.
e Save as PST (Microsoft Outlook)
e Save as EML (Outlook Express)
e Save as MSG (Microsoft Outlook)

e Save as DBX (Outlook Express)

= All four options will be available once you buy the software.
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[K] Kernel for Outlook

Fil=  Tools  Help

bH%s@‘ﬂ Kernel

‘ Repair Save  LivelUpdate  Help  Buy Cniine Recovery Tools

'KERNEL OUTLOOK PST REPAIR

() Save as PST [ Microsoft Outlook |
) Save as EML [ Outlook Express ]
) Save as MSG [ Microsoft Outlook )
() Save as DBX [ Outlook Express ]

|« Back | | save |

Kernel for Outlook | Done SCRL

Figure 4.5: Saving Options

8. Choose the desired option and click the “Save” button to save the recovered results. Software asks
you for the location where you want to save the results.

9. Browse for the desired location and click OK to save at the selected location.
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Browse for Folder

Flease select the path to Save the folder

g Local Disk (E:)
g Local Disk (F:)

e DISKL WOLZ (G0
) e DISK1 MOLZ {H:)
|50 Kernel PST
|5 ©utlook Files

o }recovered PST Files
|53 sample-help
=) Submissian
G- Conkrol Panel
|3 Shared Documents

|53 Meha's Documents
=+l {b‘l hnkia Phone Rroscer

(>

[%

(0] 4 l [ Cancel

Figure 4.6: Browse for Folder
Software now saves the repaired PST files in new .PST file.

10. Click on the Finish button to return to the main window of software. Click ‘X’ button to exit from the
software.
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5. Full Version

Although you can use Kernel for Outlook evaluation version for free and experience the capabilities of the
software, there are certain features that are not available in the evaluation version.

5.1 Requirement of Full Version

By using the evaluation version of Kernel for Outlook, you can repair corrupt .pst files; however, you
cannot save the content of the repaired files.

You will need to buy the full version of the software to save the repaired .pst file items.

5.2 Purchasing Full Version

You can buy the full version of Kernel for Outlook from any one of our authorized resellers — Element5,
Asknet and 2CO.

As soon the purchase transaction with our resellers gets completed, our sales team will send you an email
comprising the URL to download the full version of Kernel for Outlook and activation details of the
software.
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6. Support

We have an extensive and efficient support system in place to assist our customers with all issues related
to using Kernel for Outlook. The software comes with an embedded help manual that can be accessed by
clicking Help>Software Help in the menu-bar. You can also press the F1 key on the keyboard of your
computer to access the embedded help of Kernel for Outlook.

You can access the online help for Kernel for Outlook at http://www.nucleustechnologies.com/Online-
Helps.html

View Animated Working demo of the software at
http://www.nucleustechnologies.com/Animated Demo PST.html

We also have live support wherein you can chat with our software experts at
http://www.nucleustechnologies.com/Support.html

To talk on phone with our software experts call:

Help line:

+91-9818725861
1-866-348-7872 (Toll Free for USA/CANADA)
You can also email us about your queries at;

sales@nucleustechnologies.com for Sales

support@nucleustechnologies.com for Support

contact@nucleustechnologies.com for General Queries
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/. Troubleshooting

This section deals with your generic and specific queries pertaining to using Kernel for Outlook.

7.1 Common Issues

Why does Kernel for Outlook have limitations in evaluation copy?

The free evaluation version of Kernel for Outlook is intended to enable you to experience the capabilities
of the software. You will need to buy the software to save the recovered PST file items.

7.2 Frequently Asked Questions

How to Buy Kernel for Outlook?

You can buy Kernel for Outlook online at http://www.nucleustechnologies.com/Buy-Microsoft-Outlook-
Mails-Recovery-Software.php

| have lost my full version for Kernel for Outlook. Can you help me?

Please email us at sales@nucleustechnologies.com. Please include your name, address, email address,
and order confirmation number (if you have it). We will be happy to help you.

| cannot view the toolbar. How can | view it?

The tool-bar in Kernel for Outlook is by default visible. It might have become invisible by someone
accidentally changing the settings.

Click Tools = Standard to make the tool-bar visible again.
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8. Legal Notices

This section comprises the legal specification about Kernel for Outlook and the company NUCLEUS DATA
RECOVERY.COM PRIVATE LIMITED

8.1 Copyright

NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED, Nucleus Kernel accompanied user manual and
documentation are copyright of NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED, with all rights
reserved. Under the copyright laws, this user manual cannot be reproduced in any form without the prior
written permission of NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED. No Patent Liability is
assumed, however, with respect to the use of the information contained herein.

© NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED. All rights reserved.
8.2 Trademark

Nucleus Kernel ® is a copyright work of NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED

Windows 95®, Windows 98®, Windows ME®, Windows NT®, Windows 2000 Server®, Windows 2000
Advanced Server®, Windows 2003 Server®, Windows XP®, Windows Vista, MS-DOS and MS Office are
registered trademarks of Microsoft Corporation.

All other brand and product names are trademarks or registered trademarks of their respective companies.

8.3 Disclaimer

The Information contained in this manual, including but not limited to any product specifications, is subject
to change without notice. NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED provides no warranty
with regard to this manual or any other information contained herein and here by expressly disclaims any
implied warranties of merchantability or fithess for any particular purpose with regard to any of the
foregoing NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED assumes no liability for any damages
incurred directly or indirectly from any technical or typographical errors or omissions contained herein or
for discrepancies between the product and the manual. In no event shall NUCLEUS DATA
RECOVERY.COM PRIVATE LIMITED, be liable for any incidental, consequential special, or exemplary
damages, whether based on tort, contract or otherwise, arising out of or in connection with this manual or
any other information contained herein or the use there of.

8.4 License Agreement

Kernel for Outlook Copyright © by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED
Your Agreement to this License

You should carefully read the following terms and conditions before using, installing or distributing this
software, unless you have a different license agreement signed by NUCLEUS DATA RECOVERY.COM
PRIVATE LIMITED. The terms and conditions of this License describe the permitted use and users of
each Licensed Copy of Kernel for Outlook. For purposes of this License, if you have a valid license, you
have the right to use a single Licensed Copy of Nucleus Kernel.
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Scope of License

Each Licensed Copy of Kernel for Outlook may either be used by a single person or used non-
simultaneously by multiple people who use the software personally installed on a single workstation. All
rights of any kind in Nucleus Kernel, which are not expressly granted in this License, are entirely and
exclusively reserved to and by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED. You may not rent,
lease, modify, translate, reverse engineer, decompile, disassemble, or create derivative works based on,
Nucleus Kernel, nor permit anyone else to do so. You may not make access to Nucleus Kernel available
to others in connection with a service bureau, application service provider, or similar business, nor permit
anyone else to do so.

Warranty Disclaimers and Liability Limitations

Kernel for Outlook, and any and all accompanying software, files, data and materials, are distributed and
provided AS IS and with no warranties of any kind, whether expressed or implied. In particular, there is no
warranty for the quality of data recovered. You acknowledge that good data processing procedure dictates
that any program, including Nucleus Kernel, must be thoroughly tested with non-critical data before there
is any reliance on it, and you hereby assume the entire risk of all use of the copies of Nucleus Kernel
covered by this License. This disclaimer of warranty constitutes an essential part of this License. In
addition, in no event does NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED authorize you or
anyone else to use Kernel for Outlook in applications or systems where Kernel for Outlook failure to
perform can reasonably be expected to result in a significant physical injury, or in loss of life. Any such use
is entirely at your own risk, and you agree to hold NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED
harmless from any and all claims or losses relating to such unauthorized use.

General

This License is the complete statement of the agreement between the parties on the subject matter, and
merges and supersedes all other or prior understandings, purchase orders, agreements and
arrangements. This License shall be governed by the laws of the State of Delhi. Exclusive jurisdiction and
venue for all matters relating to this License shall be in courts and for a located in the State of Delhi, and
you consent to such jurisdiction and venue. There are no third party beneficiaries of any promises,
obligations or representations made by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED herein.

Any waiver by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED of any violation of this License by
you shall not constitute, nor contribute to, a waiver by NUCLEUS DATA RECOVERY.COM PRIVATE
LIMITED of any other or future violation of the same provision, or any other provision, of this License.
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